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Instructions for CST simulation
Step-by-step guide

This manual is meant to guide you through the creation of a simulation environment in CST and the extraction of all
the relevant results. Read the document carefully before performing a simulation and feel free to give us feedbacks
on its organization.
Part 1 of the tutorial focuses on the creation of the template: you will select the physics of your problem and
specify the wavelength (or frequency) range of the simulation.
Part 2 guides you through the assembling of the geometry and the definition of the parameters of the solver:
you will define shapes, materials and boundary conditions for the geometry, create field sources and field probes,
and finally setup the solver by specifying inputs, outputs and which type of calculation CST should perform.
Part 3 explains how to analyze the results of the simulation: you will see how to create 1D, 2D and 3D plots and
how to export results to be post-processed with other softwares.

Contents

Access CST through VDI . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1

1. Creating the template . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2

2. Building the geometry, source(s) and boundary condition . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.1 CST environment and parameter list . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6

2.2 Basic geometry creation and transformation . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7

2.4 Creating 3D object by extruding 2D geometry . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9

2.5 Material assignment . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11

2.7 Defining the background . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13

2.8 Waveguide port and other sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14

2.9 Boundary conditions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16

2.10 Mesh . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17

2.11 Post processing, probes and monitors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18

2.12 Setup solvers: time domain and frequency domain . . . . . . . . . . . . . . . . . . . . . . . . . 21

2.14 Parametric sweep . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24

3. Plotting/extracting the results: . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25

Appendix: Tutorial of creating bend waveguide . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27



Access CST through VDI

You will perform simulations on a virtual machine. Follow these steps to access it. If you have troubles at some
point, don’t hesitate to tell us, it might be because you are not added to the list of the course.

1. Install VMware Horizon from https://vdi.epfl.ch/ (might be already installed on the computers in the exercise
classrooms.

2. When you connect the first time on the Vmware Horizon you must enter ”vdi.epfl.ch” for the Server.

3. Login with your Gaspar credentials and you should be able to see the STI-CST-HP.

4. Enter STI-CST-HP and search for CST in the program list.

BE CAREFUL: data saved locally on the server will be deleted. Remember to save them on a network or through
external storage places such as Drive or Dropbox.
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1. Creating the template

To perform simulations in CST, the first step is to define the simulation template. You can follow the steps below,
where you will find explanations in the text as well as screenshots of each step in the following pages. Additionally,
you can watch the video tutorial provided by the CST Microwave Studio software itself.

• Steps 1.1 and 1.2: Click on Project template. You will see different frameworks to create your model.
For simulating all the structures we will analyze during this course, we should select Microwaves and
RF/Optical then Optical Applications framework, then click on ”Next”.

• Steps 1.3 and 1.4: After choosing this framework, you can now choose Dielectric structre to simulate
optical waveguides, while in the future exercises we will use Plasmonic/Metallic structures for the analysis
of bow-tie antennas.

• Steps 1.5 and 1.6: You have now to select the component category: for the dielectric slab waveguide you can
choose ”Optical waveguides, Couplers, and Filters”, while in the future antenna exercise you will choose
Nano antennas (under the Plasmonic/Metallic structures menu).

• Step 1.7: At this point you can choose the solver: either Time domain or Frequency domain solvers
depending on the type of simulation you want to run (usually specified in the text of the exercises). The latter
is usually preferred when you need to perform a simulation for a fixed frequency and not a range as for the
other. You will also be able to change the solver later in the software.

• Step 1.8: Choose the desired units for your simulation. We suggest um, THz and ps for wavelength (and
geometrical dimensions), frequency, and time respectively.

• Step 1.9: Enter the wavelength (or frequency) range in which the simulation will be performed (usually
suggested in the text of the exercise). In the Monitors section you can choose the results you want CST to
calculate, such as electrical or magnetic fields. In the Define at, you should specify the calculation wave-
length (or frequency) for these monitors. Note that monitors also can be added or modified later in the
software.

• Step 1.10: Finally, you just give your template a name! ,
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2. Building the geometry, source(s) and boundary condition

Disclaimer: most of the operations here described can be easily performed from the Navigation Tree panel found
by default on the left of the screen (see the figure in point 2.1). You can right-click on an element of the tree and
see the list of available actions you can perform.

2.1 CST environment and parameter list

• 2.1) You can now start with the creation of the geometry. To do so, you need to define the parameters of your
design in CST. By opening the Parameters List, you can specify the Name of your parameters, their value
under Expression (the unit of measure is the one specified before during the creation of the template), and a
short comment under Description.
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2.2 Basic geometry creation and transformation

• 2.2) For creating our geometry, we take the slab waveguide exercise as an example, which involves basically
a rectangular film. In Modeling, click on Brick and press Esc button on your keyboard to open the ”Brick”
interface. Give your film a name, and define its minimum and maximum coordinates along x, y and z axes.
Finally, assign a Material to the brick following the guidelines in point 2.5. You will be able to assign a
different material also later, from the Navigation Tree.

(In case a newly generated brick had an intersection with the another one created before, CST would ask
you the operation to perform between them: usually, you would need to select the Trim option, which will
insert the first brick inside the new one but correctly keeping the assigned materials. Many other geometrical
options are available for the creation of 3D or 2D structures, as you will also see in steps 2.3 and 2.4. Check
the instructions at the end of the document for an example on the creation of a bent waveguide.)
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• 2.3) CST allows to perform geometrical transformation on an existing object. As shown below, you can
perform Translation, Scale, Rotate, and Mirror on you exiting object. So you don’t need to create new
objects with the same geometry, only to change their position or scale

You can also find the Transform menu under Modeling, together with other functions to Align shapes,
create a Bend or perform Boolean operations between 3D objects. This final option is fundamental when
two bricks have an intersection.
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2.4 Creating 3D object by extruding 2D geometry

• 2.4a) You can not only create 3D objects, but also 2D objects with standard curve shapes or a free polygon.
You can even define your desired mathematical expression to create an arbitrary curve (but don’t worry about
this option for this course ,).
To create for instance a more complex structure as the wing of a bow-tie antenna, under Modeling you can
select Curves and Polygon. A new window will open, where you can enter the coordinates of the vertices of
the polygon. Alert: to close the polygon, be careful in repeating the first point you specify in the list also as
the last one. At this point, you can go on with the extrusion of the curve (see point 2.3b).
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• 2.4b) You can now extrude the curve you have just created: the Extrude icon under Modeling becomes
available only after the creation of the polygon. Click on it and select the curve to extrude. In the new
window you can specify the thickness of the final 3D shape (together with a twist angle for more complex
geometries) and its material.
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2.5 Material assignment

• 2.5) While creating the brick, you can assign it a new material, or choose a material from your material
library. In the first case, specify its permittivity as (for simplicity) the square of the refractive index. For
more refined simulations, one can instead specify the dispersion relation of the material in the window about
Dispersion, as shown in point (2.4b).
If you want to assign a different material to a brick after its creation, right-click on the brick in the
Navigation Tree and select Assign material and color from the list.
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• 2.6) You can select and define materials also from the Modeling menu, or even from main tree under on the
left of the general interface: right-click on Materials and select New Material. The same window will open
for both cases.

When defining a new material, you can specify its dispersion relation for a simulation in a large frequency
range, or to have a more accurate result even for small ranges. To do so, in the New material window, select
Dispersion in the top list and choose the User defined option. Click on Dispersion list and then Load file
to select the dispersion relation (saved usually in a .txt file) and set the Error limit to 0.001. This is the error
between the dispersion just uploaded and the fit performed by CST: you can check the precision of the fit
under 1D Results (in the Navigation Tree) selecting the name of the material you created.
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2.7 Defining the background

• 2.7) After having created the core of your structure, an efficient procedure for the creation of substrate and
cladding, alternative to the creation of 2 dedicated bricks, is to define them at once using the Background
interface. You can either go through Modeling or Simulation and click on Background. Background
Properties window will appear: the background will surround your existing geometry and you can here
specify its maximum the distance in every direction. Tick Multiple Layers and enter the height and material
of each layer. At the beginning, the structure’s corner will be at the center of the coordinate system, so you
need to adjust the Offset to bring the background in the same center as the ridge. The orientation of this
offset depends on how your structure itself is oriented as it should always be referred to the thickness of the
layers: in this example, thicknesses are defined along Y and so does the offset, in other assignment is may
vary.
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2.8 Waveguide port and other sources

• 2.8a) One important step before running the simulation, is to define a source for the optical wave! To do so,
in Simulation click on Waveguide Port. You can give your ”in-port” a name, specify its orientation and
define the number modes that CST will calculate. In order to retrieve the S-parameters of the structure
later on, define another port as an ”out-port” by selecting the Negative orientation. As the modal analysis
depends on the section of the waveguide, if the structure is symmetrical for input and output ports you can
analyze the modes on only one of them, since they will be the same for the other.

14



• 2.8b) Besides the waveguide port, in CST you can also define other types of sources for your optical field
(i.e., discrete ports, plane waves, lumped elements etc.) that can be found under Simulation and Source and
loads. Moreover, one could define electric dipoles and magnetic dipoles, as for instance the Hertzian dipole
(you can learn more about it in BALANIS, Constantine A. Antenna theory: analysis and design, chapter 4).
To create this particular source, follow Home → Macros → Solver → Sources → → Hertzian Dipole.
You need at this point to enter the parameters of the antenna, including the direction of the field, operating
frequency range, background properties and power.
Using the Macros menu, you can find many other interesting functionalities in CST.
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2.9 Boundary conditions

• 2.9) Time to set-up the boundary conditions! The default boundary box in ideally infinite in all directions,
therefore you can set an Open boundary condition in every direction. Other types of boundary conditions
(again not used during this course) might reduce the computational time by exploiting symmetries of the
electric or magnetic field or considering a periodic or perfectly conductive wall.
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2.10 Mesh

• 2.10) Once the structure of our simulation is complete, we have to define a Mesh: mesh setting determines
the accuracy of the numerical simulation creating small domains in which the solver can more easily compute
the solution. However, a too fine mesh will lead to an extremely long simulation time. As a consequence,
there is a trade-off between the error of calculation and the time and memory that the simulation requires.
Usually, depending on the structure, some mesh tests are necessary to tune the properties of the mesh: if
the default values provided by CST lead to an error, it probably means you need to refine the mesh until the
solution can be computed.
To modify mesh parameters, in Home click on Mesh View to open the Mesh menu, where you can choose
the position and orientation of the cut-plane. Then click on Global Properties: here you can modify the
number of cells in the whole simulation space. In the example shown below, the number of mesh cells per
wavelength is chosen to be 4. Change it and see how increasing or decreasing the mesh affects the simulation
time and results. Click on Close Mesh View to go back to the normal interface.

For more refined simulations (that we will not be able to perform during this course), there is the possi-
bility to finely tune the local mesh in the region of higher interest (as the core of a waveguide) without
affecting the most lateral portions: after selecting one of the solids from the Navigation Tree (found under
Component), the Local Properties option will become available in the Mesh menu. You will be able in this
way to refine the mesh for that single solid.
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2.11 Post processing, probes and monitors

• 2.11) A powerful tool in CST is the possibility to automatically compute a large variety of parameters during
the general simulation: you can use the Result Templates window under Post Processing. For example,
if you need to calculate the effective refractive index of the structure, from Optical, choose Calculate the
effective index for waveguide modes. You can choose other post-processing options as shown in the figure
below. However, many operations (as for instance the analysis of the electric field in the structure) are only
available after the simulation and can be added to the Result Templates list a posteriori.
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• 2.11b) You can measure the field in specific points by putting probes at the positions you need. Choose Field
Probe under Simulation, then specify its coordinates and which field it should evaluate.
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• 2.11c) In order to see, instead, the field distributions in the whole domain, you need to define near field or far
field monitors. In Simulations, click on Field Monitors. In order to see the electric fields at the frequency
of your interest, tick E-Filed and enter the frequency. You can add multiple frequencies, or even a sweep
or a range! In order to see the far-field pattern, click instead on Far Feild/RCS. After the simulation is
concluded, you will see the results of the near-field monitors under 2D/3D Results and the results of the far
fields monitors under FarFields, both in the main Navigation Tree.
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2.12 Setup solvers: time domain and frequency domain

• 2.12) The final step before launching the simulation is to setup the parameters of the solver itself. In Home,
there are several Setup Solver modes, but the two commonly used in this course are the Time domain
setup-solver and the Frequency domain setup-solver. For time domain, you can set the Accuracy of the
frequency domain signals calculated by Fourier Transformation of the time signals. For a more accurate
simulation, this parameter can be decreased, but it might lead to errors with the mesh set before. With a
coarse mesh, simulations with high accuracy (so smaller specified value) may not converge.
As shown below, the Time Domain window allows you to choose the source of the simulation from the ones
you created before by selecting which port and which mode will excite the structure. For a quick modal
analysis (which does not require to calculate any propagation along the 3D domain), you can tick the option
to Calculate port modes only. Modes will be computed at the central wavelength (frequency) of the range
specified at the beginning.
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• 2.12b) You can also excite multiple ports or multiple modes by following the steps below:
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• 2.13) Also in the Frequency domain setup-solver you can choose to calculate port modes only. You can
also define the number of frequency samples for your simulations (single or equidistant points). By default,
if you click on Calculate port modes only, CST skips the full frequency sweep and only calculates the effec-
tive refractive index of the modes at the central frequency of the one specified under Simulation. Instead, if
you want to calculate the group refractive index, you need to run a complete simulation setting a frequency
range (as shown in the pictures) and UN-TICKING the option to Calculate port modes only. Note that the
frequency range in the solver must be smaller that the maximum range, otherwise you will get the error
shown in red on the bottom left of the picture.
In order to speed up the simulation UN-TICK the option for Adaptive tetrahedral mesh refinement, oth-
erwise the software would iterate the simulation trying to automatically adapt the mesh.
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2.14 Parametric sweep

• 2.14) In order to perform a parametric sweep in CST, in Home choose Par. Sweep and then, in the new
window, click on New Seq. You can add different sequences that will be computed separately. Moreover,
you have the possibility to perform ”multidimensional” sweeps adding more parameters under the same
sequence, all the combinations between them will be computed.
To choose the parameter you want to sweep, select New Param and find its Name. You also can determine
the Type of the sweep, but in this course we will only do linear sweeps. Specify starting and ending of
the sweep in From and To boxes, respectively. You can do the sweep either for a predefined Number of
samples, or in predefined Step width, CST will divide the range specified accordingly. At the end, just press
start to run the full simulation.
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3. Plotting/extracting the results:

There are several options for plotting and extracting 0D, 1D, 2D, and 3D data from CST simulations. Here, we
only mention a few of them:

• 3.1) and 3.2) On the View tab, Mouse Control, you can choose the desired 3D rotation or in-plane rotation.
You can also choose them from the gray taskbar at the right bottom of the screen. In View you can also select
specific orientations of the geometry (useful for instance to plot field on 2D planes).

• 3.3) You can look at several 1D, 2D/3D plots by clicking on the 1D Results or 2D/3D Results on the
Navigation Tree (left panel). Several options such as field component, mode frequency, color range, and
sectional views are available on the 2D/3D plot panel. Remember that many 2D or 3D results can be obtained
only defining a proper Field monitor at the desired frequency.

• 3.4) You can also animate the field (by sweeping the phase) and check the propagation along the structure.

• 3.5) As mentioned before, another important tool is the Result Template interface under Post Processing
(also found in 2D/3D Plot tab when a 2D or 3D result is open), through which you can extract and plot
customized 0D, 1D, 2D, and 3D plots from the simulated data.

• 3.6) Data from 1D results plots (and also from 2D or 3D, but we will not need them) can be extracted as a
CSV file from Post Processing and Import/Export, selecting Plot data ASCII.

• 3.7) CST can calculate the effective refractive index of the port modes in your structure. You can add this
parameter to your list in Result templates.
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• 3.8) You can define cut-lines with the following procedure: after the simulation is done, under Post Process-
ing select Results template → 2D and 3D Field Results → Evaluate field in arbitrary coordinates. A
new window will appear, here:

1. click on Browse Results and choose the field result of you interest.

2. Select the desired component of the field and always choose to calculate its Real part.

3. Select 1D = Curve Line and specify the orientation of the line.

4. Define the coordinates of the line. You can draw the line along the full structure ticking the Max.
range.

5. Click Ok and continue.

Once you have set al the parameters, give a useful name to the cut-line and finally click on Evaluate for each
cut-line, separately.

Appendix: Tutorial of creating bend waveguide

See Next pages.
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Tutorial to create the bend at the end of a waveguide 

1-Make a waveguide. Put the end of the waveguide until    
𝐿

2
− 𝛿 − 2 ×𝑊𝑤𝑔1 

center is dist+𝑊𝑤𝑔1 

 

2-Create a Cylinder from Modeling>shapes>Cylinder with the following parameters:  

 

 



3-Create a Brick with the following parameter: 

 

 

 

 

 

4- Intersect the cube and the cylinder via Boolean Operations in Modeling tab 

 



5-Create another Brick for the tail of the bend with the following parameters:

 

 

 

 

6-Merge the waveguide, the curve, and the tail using Add in Boolian Operations: 

 

 

 

 

 

 

 



7-To have the waveguide inside the cladding, make a copy of waveguide (Wg1_1 in figure). Then, use 

the subtract in Boolean Operations. First select the cladding, then choose subtract from the Boolean 

Operations and finally choose the waveguide (Wg1_1) and then press Enter for subtracting 

waveguide from the cladding.
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